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Reference to the whole or to part of this volume should be made as follows: 

Print citation for Chapter 1:
Shipboard Scientific Party, 2002. Leg 194 summary. In Isern, A.R., Anselmetti, F.S., Blum, P., et al., 
Proc. ODP, Init. Repts., 194: College Station TX (Ocean Drilling Program), 1–88.

CD-ROM volume citation:
Isern, A.R., Anselmetti, F.S., Blum, P., et al., 2002. Proc. ODP, Init. Repts., 194 [CD-ROM]. Available 
from: Ocean Drilling Program, Texas A&M University, College Station TX 77845-9547, USA.

CD-ROM chapter citation:
Shipboard Scientific Party, 2002. Site 1192. In Isern, A.R., Anselmetti, F.S., Blum, P., et al., Proc. ODP, 
Init. Repts., 194, 1–75 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M University, 
College Station TX 77845-9547, USA.

This volume also appears on the World Wide Web. See www-odp.tamu.edu/publications for Web 
citation formats.

http://www-odp.tamu.edu/publications
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Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 
printing date, is the correct one.
The printing date of this volume: March 2002

The mailing dates of recent Proceedings of the Ocean Drilling Program:
Volume 191 (Initial Reports): September 2001
Volume 192 (Initial Reports): November 2001
Volume 193 (Initial Reports): January 2002
Volume 172 (Scientific Results): September 2001
Volume 173 (Scientific Results): August 2001
Volume 174B (Scientific Results): July 2001

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the 
ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 
information. Orders for copies require advance payment.

ISSN
Book: 0884-5883; CD-ROM: 1096-2522; World Wide Web: 1096-2158
Library of Congress 87-642-462

http://www-odp.tamu.edu/publications
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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any scientific corrections, revisions, or additions will 
be noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 

Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:

Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 
The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 

in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College Station 
TX 77845-9547, USA (e-mail: database@odpemail.tamu.edu).

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of 
Paul Wessel and Walter H.F. Smith (gmt.soest.hawaii.edu).

Cover photograph is of a thin section of Sample 194-1196B-1R-1, 0 cm, by Co-Chief Scientist Flavio S. 
Anselmetti. The horizontal image width = 1 mm. Ferromanganese laminations of submarine 
hardground from the modern seafloor at 304 meters below sea level directly overlie the southern 
Marion platform edifice. This hardground surface formed after carbonate platform production ceased 
and the platform drowned in the late Miocene. Thereafter, strong bottom currents prevented 
deposition of Pliocene–Holocene sediments, favoring formation of hydrogenetic mineralizations.

http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
http://gmt.soest.hawaii.edu
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.
The management of ODP involves a partnership of scientists and governments. International oversight and 
coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 16 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 
science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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OCEAN DRILLING PROGRAM*
National Science Foundation
4201 Wilson Boulevard
Arlington VA 22230, USA
Tel: (703) 306-1581; Fax: (703) 306-0390
Web site: www.nsf.gov

MEMBER ORGANIZATIONS OF THE JOINT OCEANOGRAPHIC INSTITUTIONS FOR DEEP EARTH 
SAMPLING (JOIDES)

Columbia University, Lamont-Doherty Earth 
Observatory

Florida State University

University of Florida
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Science, and the Arts

University of Rhode Island, Graduate School of 
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University of Texas at Austin, Institute for 
Geophysics

University of Washington, College of Ocean and 
Fishery Sciences

Woods Hole Oceanographic Institution

*At time of publication. See Publisher’s Notes, p. 5, for list of funding agencies at time of cruise. For an up-to-date list of
current member organizations and office contact information, see the ODP Web site: www.oceandrilling.org.

http://www.nsf.gov/
http://www.oceandrilling.org/
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Australia/Canada/Chinese Taipei/Korea 
Consortium for Ocean Drilling: Department of 
Primary Industries and Energy (Australia), 
Natural Resources Canada, National Taiwan 
University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

European Science Foundation Consortium for 
Ocean Drilling (Belgium, Denmark, Finland, 
Iceland, Ireland, Italy, The Netherlands, Norway, 

OCEAN DRILLING PROGRAM (ODP)

Web site: www.oceandrilling.org

ODP SCIENCE ADVISORY STRUCTURE 
(JOIDES)

JOIDES Office
University of Miami—RSMAS
Portugal, Spain, Sweden, and Switzerland)

Federal Republic of Germany, Bundesanstalt für 
Geowissenschaften und Rohstoffe

France, Institut National des Sciences de 
l’Univers–Centre National de la Recherche 
Scientifique (INSU-CNRS)

Japan, University of Tokyo, Ocean Research 
Institute

People’s Republic of China, Marine High-
Technology Bureau of the State Science and 
Technology Commission of the People’s 
Republic of China

United Kingdom, Natural Environment Research 
Council 

4600 Rickenbacker Causeway
Miami FL 33149, USA
Tel: (305) 361-4668; Fax: (305) 361-4632
E-mail: joides@rsmas.miami.edu
Web site: joides.rsmas.miami.edu

http://www.oceandrilling.org/
mailto:joides@rsmas.miami.edu
http://joides.rsmas.miami.edu
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ODP PROGRAM MANAGER

Joint Oceanographic Institutions, Inc.
1755 Massachusetts Avenue, NW, Suite 700

ODP LOGGING SERVICES OPERATOR

Borehole Research Group
Lamont-Doherty Earth Observatory
Washington DC 20036-2102, USA
Tel: (202) 232-3900; Fax: (202) 462-8754
E-mail: joi@science.org
Web site: www.joiscience.org

ODP SCIENCE OPERATOR

Ocean Drilling Program
Texas A&M University
1000 Discovery Drive
College Station TX 77845-9547, USA
Tel: (979) 845-2673; Fax: (979) 845-4857
E-mail: odp@odpemail.tamu.edu
Web site: www-odp.tamu.edu

Columbia University
Route 9W
Palisades NY 10964, USA
Tel: (845) 365-8341; Fax: (845) 365-3182
E-mail: borehole@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/BRG/ODP

ODP SITE SURVEY DATA BANK

Lamont-Doherty Earth Observatory
Columbia University
Route 9W
Palisades NY 10964, USA
Tel: (845) 365-8542; Fax: (845) 365-8159
E-mail: odp@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/databank

mailto:joi@science.org
http://www.joiscience.org
mailto:odp@odpemail.tamu.edu
http://www-odp.tamu.edu/
mailto:borehole@ldeo.columbia.edu
http://www.ldeo.columbia.edu/BRG/ODP
mailto:odp@ldeo.columbia.edu
http://www.ldeo.columbia.edu/databank
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mailto:flavio@erdw.ethz.ch
mailto:blum@odpemail.tamu.edu
mailto:nandresen@geomar.de
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CD-ROM CONTENTS: CORE DESCRIPTIONS
Visual core descriptions (VCDs), smear slide and thin section data tables, and digital core images are 
included in this section. ASCII versions of the smear slide and thin section data tables are also available 
(see “ASCII Tables”).

Site 1192

Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1193

Visual Core Descriptions · Smear Slides · Thin Sections 
Site 1194

Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1195

Visual Core Descriptions · Smear Slides · Thin Sections 

Sites 1196 and 1199

Visual Core Descriptions · Thin Sections 

Site 1197

Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1198

Visual Core Descriptions · Smear Slides · Thin Sections 
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of all of the smear slide data tables and thin section data 
tables presented under “Core Descriptions.” A complete listing of the smear slide and thin section 
data tables can be found on the next page. 

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

WINDOWS COMPUTERS

By default, double-clicking on a filename with a .TXT extension will launch the Notepad application. 
You can configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 
ME, and XP systems: View > Folder Options > File Types.

MACINTOSH COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly 
from PDF files.

Smear slide data tables Thin section data tables 
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Smear Slide Data Tables
Site 1192 smear slide table.
Site 1193 smear slide table.
Site 1194 smear slide table.
Site 1195 smear slide table.
Site 1197 smear slide table.
Site 1198 smear slide table.

Thin Section Data Tables
Site 1192 thin section table.
Site 1193 thin section table.
Site 1194 thin section table.
Site 1195 thin section table.
Site 1196 thin section table.
Site 1197 thin section table.
Site 1198 thin section table.
Site 1199 thin section table.
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CD-ROM CONTENTS: OVERSIZED FIGURES
These figures are printed on the oversized foldout that is located in the front pocket of this 
publication. They are also available as oversized figures in PDF format on the Initial Reports CD-ROM 
included with this publication.
Chapter 1, Leg 194 Summary
Figure F10A. Parts of seismic sections MAR13, MAR20, MAR15, and MAR07 with locations of all Leg 
194 sites.

Figure F10B. Stratigraphic correlation summary for Leg 194.

CD-ROM CONTENTS: QUICKTIME MOVIES
This CD-ROM contains QuickTime movies for Figure F3 in Chapter 4 and Figure F3 in Chapter 7. These 
movies may be viewed from within the respective chapter PDF file or opened directly from the 
MOVIES directory. QuickTime 5 software is provided on the CD-ROM but is available only for the 
Macintosh and Windows platforms. Please see “QuickTime Software” in README.PDF for information 
on installing the software. Please see \QUIKTIME\README.TXT for information on minimum system 
requirements. QuickTime and the QuickTime logo are trademarks used under license. The QuickTime 
logo is registered in the U.S. and other countries.
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CD-ROM CONTENTS: DRILLING LOCATION MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.

ODP Leg 194 Site Map 

ODP Map (Legs 100–194)

DSDP Map (Legs 1–96)
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RELATED LEG DATA
DOWNHOLE LOGGING AND CORE DATA 

A second CD-ROM is included with this volume. The “Log and Core Data” CD contains Leg 194 
depth-shifted and processed downhole logging data and shipboard core logging data (color 
reflectance, gamma ray attenuation bulk density, magnetic susceptibility, moisture and density, and 
natural gamma radiation). The downhole logging data are provided by the Borehole Research Group 
at the Lamont-Doherty Earth Observatory, Wireline Logging Operator for ODP.

Most of the logging and core data included on this CD are available on the World Wide Web at 
www.ldeo.columbia.edu/BRG/ODP. If you cannot access this site or want to order the CD, please 
contact the ODP Logging Services Operator at the Lamont-Doherty Earth Observatory, Columbia 
University, Route 9W, Palisades NY 10964, USA; Tel: (845) 365-8341; Fax: (845) 365-3182; E-mail: 
borehole@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 
If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, 
Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-
9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.

http://www.ldeo.columbia.edu/BRG/ODP
mailto:borehole@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the volume 
CD-ROM contains individual indexes of Volumes 101–173 and 174B. The indexes are contained in the 
directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). These indexes can 
be searched individually or collectively.
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CD-ROM DIRECTORY STRUCTURE 

ACROREAD
(Acrobat Reader 4.0.5 installation 
software and instructions for 
different platforms)

194IR.PDF
(Preliminary pages and table of contents)

README.TXT

IR194_01.PDF (Leg 194 Summary)VOLUME
(Leg 194 Initial Reports volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(Information about the volume CD-ROM in ASCII format)

MAPS
(Drilling location maps)

ODPMAP.PDF
(ODP map, Legs 100 through 194)

CHAPTERS
(Volume chapters)

194_MAP.PDF
(Leg 194 site map)

IR194_02.PDF (Explanatory Notes)

IR194_03.PDF (Site 1192)

IR194_04.PDF (Site 1193)

IR194_05.PDF (Site 1194)

IR194_06.PDF (Site 1195)

DSDPMAP.PDF
(DSDP map, Legs 1 through 96)

TABLES
(ASCII versions of smear slide and 
thin section data tables)

S_SLIDES (Sites 1192 through 1198)

T_SECT (Sites 1192 through 1199)

README.TXT

OVERSIZE
(Large-format figure)

IR194_01 (Chapter 1 files)

IR194_07 (Chapter 7 file)

COR_1192.PDF (Site 1192)CORES
(Visual core descriptions, smear
slide and thin section 
data tables, and digital core 
images)

COR_1193.PDF (Site 1193)

COR_1194.PDF (Site 1194)

IMAGES (PDF files of core images)

IR194_07.PDF (Sites 1196 and 1199)

IR194_08.PDF (Site 1197)

COR_1195.PDF (Site 1195)

COR96_99.PDF (Sites 1196 and 1199)

COR_1197.PDF (Site 1197)

README.TXT

MAC

UNIX

WINDOWS

IR194_09.PDF (Site 1198)

COR_1198.PDF (Site 1198)

IR194_04 (Chapter 4 file)

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the
194 Initial Reports)

MOVIES
(QuickTime movies)

(Continued on next page)
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CD-ROM DIRECTORY STRUCTURE (CONTINUED)
ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

101NDX.PDF through 173NDX.PDF 
and 174BNDX.PDF 
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)

QUIKTIME
(QuickTime 5.02 installation 
software and instructions for 
different platforms)

MAC

WINDOWS

README.TXT
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